Important User Information

Solid-state equipment has operational characteristics differing from those of electromechanical equipment. Safety Guidelines for the Application, Installation and Maintenance of Solid State Controls (publication SGI-1.1 available from your local Rockwell Automation® sales office or online at http://www.rockwellautomation.com/literature/) describes some important differences between solid-state equipment and hard-wired electromechanical devices. Because of this difference, and also because of the wide variety of uses for solid-state equipment, all persons responsible for applying this equipment must satisfy themselves that each intended application of this equipment is acceptable.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

---

**WARNING:** Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to personal injury or death, property damage, or economic loss.

**ATTENTION:** Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

**SHOCK HAZARD:** Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may be present.

**BURN HAZARD:** Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach dangerous temperatures.

**IMPORTANT** Identifies information that is critical for successful application and understanding of the product.
**Additional Resources**

These documents contain additional information concerning related products from Rockwell Automation.

<table>
<thead>
<tr>
<th>Resource</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Industrial Automation Wiring and Grounding Guidelines, publication 1770-4.1</td>
<td>Provides general guidelines for installing a Rockwell Automation industrial system.</td>
</tr>
<tr>
<td>Product Certifications website, <a href="http://www.ab.com">http://www.ab.com</a></td>
<td>Provides declarations of conformity, certificates, and other certification details.</td>
</tr>
<tr>
<td>Publication Number: 1609-IN012 -EN-P</td>
<td>Bulletin 1609-D Installation Instructions</td>
</tr>
<tr>
<td>Publication Number: 1609-IN013 -EN-P</td>
<td>Bulletin 1609-B Installation Instructions</td>
</tr>
<tr>
<td>Publication Number: 1609-IN014 -EN-P</td>
<td>Surge Protective Device (Cat. No. 1609-SPD) Installation Instructions</td>
</tr>
</tbody>
</table>

You can view or download publications at [http://www.rockwellautomation.com/literature/](http://www.rockwellautomation.com/literature/). To order paper copies of technical documentation, contact your local Allen-Bradley distributor or Rockwell Automation sales representative.
# Table of Contents

Introduction and Features ........................................... 5  
1609 UPS Management Software Installation ...................... 6  
  Software Setup ...................................................... 6  
1609 UPS Management Service ....................................... 7  
1609 UPS Management Monitor ..................................... 9  
Networking ............................................................. 10  
  Operation Modes .................................................... 10  
  Remote Monitoring and Control: 1609 UPS Manag. Monitor .... 11  
  Remote Monitor and Control: Internet Browser .................. 12  
1609 UPS Management Monitor operation .......................... 13  
  Top Layer Buttons .................................................. 13  
  1609 UPS Management Monitor Main Menu ................. 14  
System ......................................................................... 14  
  Login ....................................................................... 15  
  Monitor Screen .......................................................... 15  
  Font ....................................................................... 16  
  Window ..................................................................... 16  
  Close Monitor .............................................................. 16  
Configuration ............................................................... 17  
  Configuration Window ................................................ 17  
Devices ......................................................................... 18  
  Notification Users – Pager List ..................................... 18  
  Notification Users – e-mail ......................................... 18  
  Notification Users – Network Broadcast ....................... 19  
  Notification Users – SMS (Short Message Service) ........... 19  
  Color ..................................................................... 19  
  Close ....................................................................... 19  
UPS .............................................................................. 20  
  UPS Property ............................................................. 20  
  Attached Devices ......................................................... 21  
  Log Management ........................................................ 21  
  Schedule ................................................................. 22  
Action ......................................................................... 23  
  Action – Shutdown ...................................................... 23  
  Action – Logging ........................................................ 23  
  Action – Broadcasting ................................................. 23  
  Action - SMS(Short Message Service) ......................... 23  
  Action – Paging .......................................................... 24  
  Action- Command ......................................................... 24  
  Action – Alarm ............................................................ 24  
  Action - e-mail ............................................................. 24  
  Action - SNMP Trap ...................................................... 24  
  Action - Receptacle Control .......................................... 25  
Stop All Action .............................................................. 25  
Voltage Sensitivity .......................................................... 25  
Transfer Voltage ............................................................ 25
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced UPS Property</td>
<td>26</td>
</tr>
<tr>
<td>Network</td>
<td>27</td>
</tr>
<tr>
<td>Set Password</td>
<td>27</td>
</tr>
<tr>
<td>Choose Master/Slave</td>
<td>27</td>
</tr>
<tr>
<td>Wake On LAN</td>
<td>28</td>
</tr>
<tr>
<td>SNMP</td>
<td>29</td>
</tr>
<tr>
<td>SNMP Trap Number</td>
<td>30</td>
</tr>
<tr>
<td>HTTP</td>
<td>30</td>
</tr>
<tr>
<td>Control</td>
<td>31</td>
</tr>
<tr>
<td>Shutdown Now</td>
<td>31</td>
</tr>
<tr>
<td>Cancel Shutdown</td>
<td>31</td>
</tr>
<tr>
<td>Turn Receptacle Relay On</td>
<td>32</td>
</tr>
<tr>
<td>Turn Receptacle Relay Off</td>
<td>32</td>
</tr>
<tr>
<td>UPS Audible Alarm On</td>
<td>32</td>
</tr>
<tr>
<td>UPS Audible Alarm Off</td>
<td>32</td>
</tr>
<tr>
<td>10 Seconds Test</td>
<td>32</td>
</tr>
<tr>
<td>Deep Battery Test</td>
<td>32</td>
</tr>
<tr>
<td>Cancel Test</td>
<td>32</td>
</tr>
<tr>
<td>View</td>
<td>33</td>
</tr>
<tr>
<td>Meters</td>
<td>33</td>
</tr>
<tr>
<td>Event Log</td>
<td>34</td>
</tr>
<tr>
<td>History Graph</td>
<td>34</td>
</tr>
<tr>
<td>History Data</td>
<td>35</td>
</tr>
<tr>
<td>Auto Save</td>
<td>35</td>
</tr>
<tr>
<td>Remote Hosts</td>
<td>36</td>
</tr>
<tr>
<td>Bottom Layer Buttons</td>
<td>37</td>
</tr>
<tr>
<td>Main</td>
<td>37</td>
</tr>
<tr>
<td>UPS Tree</td>
<td>38</td>
</tr>
<tr>
<td>Time</td>
<td>38</td>
</tr>
<tr>
<td>Status</td>
<td>38</td>
</tr>
<tr>
<td>Diagram</td>
<td>38</td>
</tr>
<tr>
<td>Scroll</td>
<td>39</td>
</tr>
<tr>
<td>Outlet</td>
<td>39</td>
</tr>
<tr>
<td>Network</td>
<td>39</td>
</tr>
</tbody>
</table>
Introduction

Congratulations on your purchase of 1609 UPS Management Software to manage your Uninterruptible Power Supply (UPS). 1609 UPS Management Software is designed to provide end users the ability to take proactive steps to protect their equipment from power related damages. 1609 UPS Management Software allows for automatic shutdowns, scheduled shutdowns and a variety of other features that help you manage your system and its peripheral components.

1609 UPS Management Software provides detailed information about the UPS and its protected equipment. It is easy to install and program, yet has the necessary features to handle all of one's power requirements. Included is the capability for network management protocol (SNMP). 1609 UPS Management Software will disseminate UPS information into SNMP protocol and project it to the appropriate Network Management Station (NMS), such as HP OpenView. To make use of resources on the Internet, 1609 UPS Management Software also supports HTTP protocol. This enables end-users to monitor their UPS anywhere, anytime, by simply utilizing their web browser.

1609 UPS Management Software runs in the background as a Windows service, and communicates with the UPS in order to ensure that your computer and attached components are protected from any power problems.

**1609 UPS Management Software Features**

- Graceful operating system shutdown
- Scheduled tests, shutdown/restarts of the UPS, turn on/off receptacles
- Flexible events
- Notification: SMS, Pager, e-mail and audible alarm, network broadcasting and SNMP
- Real-time values of voltage, current, frequency and loading...
- Historical data & graph
- Network monitoring
- Multi-computer shutdown/restart
- Support Simple Network Management Protocol (SNMP)
- Support Universal Serial Bus (USB)
- Multi-lingual menus
1609 UPS Management Software Installation

1609 UPS Management Software Setup:

1. Turn off your computer.
2. Attach the electrical power cable from the computer to the UPS.
3. Attach the electrical power cable from the UPS to an AC power outlet.
4. Plug the communication cable into the UPS, then plug the other end of the cable into the communication port on your computer.
5. Start your computer.
6. Place the CD in your CD-ROM device and execute the setup.exe to run the setup program.
7. Check the communication type of your UPS. If you select the USB option you must have connected the UPS to this computer and install the HID driver.
8. During the installation, the following dialog gives you 3 options:
   - Program File: Files contain Service, Monitor and this on-line help.
   - Audio Files: Some .wav files. These files will be played to notify you when power event occurs.
   - SNMP Files, 1609 UPS Management Software SNMP DLL file.
9. After finishing the installation, setup program will create a 1609 UPS Management Software association.
10. The 1609 UPS Management Software is comprised of two modules:
    - An UPS Monitoring Module (1609 UPS Management Service), which runs in the background as a Windows Service and communicates to the UPS.
    - An User Interface Module (1609 UPS Management Monitor), which enables you to control and configure 1609 UPS Management Software through the drop down menus and dialog boxes. It also allows you to monitor the UPS through the Main Screen.

Help: 1609 UPS Management Software on-line help.

Uninstall: To remove 1609 UPS Management Software from your hard disk.

1609 UPS Management Monitor: User interface, used to monitor and configure UPS.

1609 UPS Management Status: Reflect the status of 1609 UPS Management Software service program, the service program is used to communicate with your UPS.
1609 UPS Management Software Service runs in the background as a Windows Service when the system initiates. You can also run 1609 UPS Management Service manually by selecting the Start Menu- Program Files - 1609 UPS Management Software - 1609 UPS Management Service. Once 1609 UPS Management Service starts there is an 1609 UPS Management Service icon located on the system tray to indicate UPS status.

Normal

![Normal](image1)

UPS Disconnect, cannot get any information from the UPS.

![UPS Disconnect](image2)

Power Failed! The UPS is operating on battery power.

![Power Failed!](image3)
Moving your mouse over the 1609 UPS Management Software icon in the system tray and click the right button to pop up the following menu:

**Show Countdown:** 1609 UPS Management Software displays the countdown time (time to shutdown/suspend the operating system) window to remind the user that the operating system will be shutdown or suspend in the displayed time. This function lets user know clearly how much time is left to shutdown/suspend the computer when power fails. The operating system shutdown time can be adjusted from the Action menu.

Monitor: Run the 1609 UPS Management Software user interface.

Configuration: Displays the configuration window, allows you to change the UPS parameters.

Meters: Shows UPS real-time meters.

Program Stop: If this item marked 1609 UPS Management Software stopped. Unmark it and the program will resume.

Once a power event has occurred, 1609 UPS Management Software will pop up a broadcast dialog box to inform user what happened to UPS.
1609 UPS Management Monitor

1609 UPS Management Monitor enables you to control and configure 1609 UPS Management Software through the drop down menus and dialog boxes. It also allows you to monitor the UPS through the Main Screen. It is not necessary for 1609 UPS Management Monitor to reside in your computer’s memory, the execution depends on the user’s requirement. This can save precious system resources.

After finishing the 1609 UPS Management Software installation, 1609 UPS Management Service automatically loads into memory and runs once the Windows operating system startup. There is an 1609 UPS Management Software icon that lies in the system tray to indicate current UPS status.

To run the 1609 UPS Management Monitor, move the mouse cursor over the 1609 UPS Management Software icon and double-click to launch 1609 UPS Management Monitor, or click the right button to pop up the menu:

Then select Monitor to run the program. You can also launch 1609 UPS Management Monitor without running 1609 UPS Management Service, select
1609 UPS Management Monitor from Program Files - 1609 UPS Management Software menu.

Networking

1609 UPS Management Software is comprised of two modules: 1609 UPS Management Service and 1609 UPS Management Monitor. You may run both the programs in a computer to monitor your localized UPS or run the programs in two different computers.

Operation Modes

1609 UPS Management Service can operate in "Master" Mode (which allows 1609 UPS Management Software to send commands to its connected UPS) in "USB Slave" mode (which listens to its connected UPS) or in "Networking Slave" mode (which obtains the UPS information from Master via the network). If two or more computers are communicating with a single UPS, only one of these
computers should be in Master mode; the others should be in Slave mode to prevent them from sending contradictory commands.

When a power event occurs, the Master gets the information then transmits it to Slave(s). Each 1609 UPS Management Service executes different "Actions" (FlexEvent) so that the system manager can configure different strategies into each different computer. For example: When a power failure occurs, the file server and mail server won't shutdown until the UPS battery is low, but other less important workstations execute shutdown after 5 minutes, and the initial workstations shutdown after 10 minutes. Shutting down workstations preserves more battery power for your mission critical network servers.

Remote Monitoring and Control: 1609 UPS Management Monitor

1609 UPS Management Monitor with the ability to monitor Local host and Remote host.

You can run only 1609 UPS Management Monitor without running 1609 UPS Management Service. 1609 UPS Management Monitor will search hosts in the LAN (Local Area Network) which runs 1609 UPS Management Service in the combo box. Click on the Host Selection combo box to list the searched hosts in
the LAN. Select one, then 1609 UPS Management Monitor will connect to the selected host.

![Remote Hosts Window]

If the host is located on the Internet, you can also input the remote host IP address from the View Menu- Remote Hosts menu shows the hosts you can establish connections with.

### Remote Monitor and Control: Internet Browser

Another way to remote monitor 1609 UPS Management Service is by using the Internet Browser. Launch the Microsoft Internet Explorer or Netscape Communicator, type the IP address in the URL and press enter you will then be able to see the UPS information. You can change the network port number to prevent conflict with other WEB server programs. If the port number isn’t 80 you have to type URL like this: http://172.16.176.141:2000 where 2000 is the port number you assigned.
1609 UPS Management Monitor operation

The Main Screen has 7 areas that present information on the operating status of your UPS. These areas are discussed in the following sections.

**Host Selection**: Press the combo box to select hosts that runs 1609 UPS Management Software in the LAN. Users can monitor or control the UPS remotely (password is needed).

**Connection Indication**: The logo will rotate while the communication between 1609 UPS Management Monitor and 1609 UPS Management Service is established.

**Information Display**: Press Bottom Layer Buttons to change the information that is displayed in this area.

**Recent Event Log**: Preserve last 10 event logs in the combo box, click on the combo box to pull down and view the logs.

**Top Layer Buttons**

| Configure | Meters | Event Log | History |

These buttons are used to increase the speed of your operation, refer to the dialog boxes in the menu.

**Configuration**: Same as the System-> Configuration in the menu.

**Meters**: Same as the View-> Meters in the menu.

**Event Log**: Same as the View-> Event Log in the menu.

**History Graph**: Same as the View-> History Graph in the menu.
1609 UPS Management
Monitor Main Menu

The Main Screen has a menu bar at the top with 5 main options:

**System**: This menu allows you to set the 1609 UPS Management Software and computer parameters.

**Control**: This menu allows you to set UPS buzzer, outlet, and test...

**View**: The View menu allows you to see the real-time values and history event or history data.

**Wizard**: Directs users to configure the most frequent use of settings, the wizard guides users step-by-step to finish their configuration.

**Help**: The Help menu allows you to access the online help system.

System

The system menu allows you to configure the UPS and monitoring screen parameters. When you select the System menu from Main Menu bar, a drop down menu appears offering you the following menu options:

<table>
<thead>
<tr>
<th>System</th>
<th>Control</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Login**: Used for Remote Monitor. User must pass the password verification before he can control or configure the UPS.

**Configuration**: The Configuration menu allows you to tailor various 1609 UPS Management Software parameters.

**Monitor Screen**: Allows you to change display item in the Scroll screen of Information Display Area

**Font**: Sets the font size. 1609 UPS Management Software will resize window automatically.

**Window**: This menu allows you to change the displayed items in the Information Display Area. The items in the menu refer to each button in the Bottom Layer Buttons.

**Close Monitor**: Stops 1609 UPS Management Monitor.
Login

![Password dialog box]

When attempting to use 1609 UPS Management Monitor as a Remote Monitor (connect to different host) you have to enter the password for verification if you want to do such tasks as configuration, or to control the UPS. Otherwise, you can only view the UPS information.

If user runs 1609 UPS Management Service and 1609 UPS Management Monitor on the same computer, you can perform such configurations or control the UPS without the password.

To change your password, please choose the Set Password from Configure - Network menu.

Monitor Screen

![Monitor Screen dialog box]

This dialog box allows you to change display item in the Scroll screen of Information Display Area.

**Language**: Choose a language that suits your operating system needs. Program will automatic replace the on-line help file and audio files to your selected preferences.

**Meters**: Press the Main button from the Bottom Layer Buttons, and you will see that there are two meters in the information area. You can change the displayed items of the two meters.
Scroll Window: Press the Scroll button from the Bottom Layer Buttons, and the scroll window will display the information in this area. This item allows you to change the display menu and its items.

Font

This menu allows you to change the font size of 1609 UPS Management Monitor window.

Window

This menu allows you to change the display items in the Information Display Area. The items in the menu refer to each button in the Bottom Layer Buttons.

Close Monitor

Close 1609 UPS Management Monitor and leave 1609 UPS Management Service running.
Configuration

The Configuration Screen has a menu bar at the top with three main options:

**Devices**: This menu allows you to configure modem, pager and e-mail applications.

**UPS**: The UPS menu allows you to plan and set the UPS schedule or perform the Action...

**Network**: This menu allows you to choose the Master/Slave settings or configure SNMP, HTTP functions.

Configuration Window

**UPS Communication Port**: COM1, ... COM4, USB.

**Next UPS Test Date/Time**: The date of the next user-initiated UPS self test. Setting from System->Configuration->UPS->Schedule.

**Next UPS Shutdown Date/Time**: This field displays the date of the next shutdown the computer and UPS. Setting from System->Configuration->UPS->Schedule.

**Next UPS Restart Date/Time**: The date of the next restart UPS. Setting from System->Configuration->UPS->Schedule.

**Local Host IP**: IP address of a computer, which runs 1609 UPS Management Monitor.

**1609 UPS Management Service Mode**: 1609 UPS Management Service acts as a Master or Slave.

**Remote Host IP**: The host, which runs 1609 UPS Management Service. If 1609 UPS Management Monitor and 1609 UPS Management Service runs on the same computer and this field will be empty.
Devices

Notification Users -- Pager List

To let 1609 UPS Management Software notify you via pager you must setup the modem device. If you select the TAPI (Windows Telephony Application Programming Interface) then Windows will handle the modem device, otherwise, 1609 UPS Management Software will control the modem device directly (AT Command).

Program will set the modem to notify all via the pager numbers, which are listed in the pager list. You can input your pager number for your own notification purposes. For example: 060123456 is your pager number, each "," tells modem to delay 2 seconds, delay time is for setting waiting period for the response signal, before proceeding to transmit to the displayed number 119. 119 will appear in your pager LCD.

To trigger the pager notification you must enable the Pager Action in the Action dialog box.

- **COM Port**: The communication port COM1, ...COM4.
- **Baud Rate**: Set the data transmitting speed.
- **Initialize String**: The string, which is sent to the modem before paging is attempted.
- **Dial Prefix**: The string, which is added to the beginning of each of the Pager Number before they are sent to the modem.
- **Using TAPI**: Lets Windows handle the modem device.
- **Add**: Add a new pager number.
- **Modify**: Modify the selected pager number.
- **Delete**: Delete the selected pager number.

Notification Users -- e-mail

You can also e-mail users through SMTP when power events occur.

To trigger the e-mail notification you must enable the e-mail Action in the Action dialog box.

- **Add**: Add a new user.
- **Modify**: Modify the selected user name.
- **Delete**: Delete the selected user.
Notification Users -- Network Broadcast

You can also broadcasting information to users when power event has occurred. The broadcast function is associated with Microsoft Messenger service.

To trigger the broadcasting notification you must enable the Broadcast Action in the Action dialog box.

- **Domain**: Enable this item to broadcast to all the users in the domain, otherwise 1609 UPS Management Software will send messages to the hosts that users assigned.
- **Add**: Add a new machine name.
- **Modify**: Modify the selected machine name.
- **Delete**: Delete the selected name.

Notification Users – SMS (Short Message Service)

To let 1609 UPS Management Software notify you via SMS (Short Message Service) you must setup the GSM modem or connect the mobile phone to your PC (Nokia is recommended).

To trigger the SMS notification you must enable the SMS action in the Action dialog box.

- **COM Port**: The communication port COM1, ...COM8.
- **Baud Rate**: Define the data transmitting speed.
- **Add**: Add a new mobile phone number.
- **Modify**: Modify the selected number.
- **Delete**: Delete the selected number.

Color

Used to change the screen color.

- **Color Items**: This area lets you select an item, which you want to change the color for. The right-top corner color will display current selected color.
- **Change**: Change the color you have selected.
- **Default**: Default setting.
- **Exit**: Close the dialog box.

Close

Close the Configuration window.
**UPS**

This dialog box allows you to configure the UPS COM port, battery replacement date, etc. Load Warning and Load Severity used to prevent UPS overload (see the UPS hardware user manual). In general, Load Warning will notify users to reduce the UPS load, Load Severity will shutdown the computer to prevent overload.

**COM Port:** COM1, ...COM4, USB.

**Load Warning:** Load warning.

**Load Severity:** User must reduce UPS load.

**Last Battery Replacement Date:** Records last battery replacement date.

**Next Battery Replacement Date:** Displays the date of the next battery replacement, 1609 UPS Management will notify users to replace the battery.

**Host Name:** Local host name.
Attached Devices

Allows the user to assign the attached device a name. When you're controlling the outlet, 1609 UPS Management Software will let you know which devices you are controlling.

**Select an Outlet Group:** Assigns an outlet group. Please look at the back panel carefully. Some outlets may share one control relay; these outlets are called outlet group. If you turn off outlet group (for example: outlet1 and outlet2) then the UPS will stop power to the outlet group outlet1 and outlet2.

**Device Name:** Assigns the attached devices a name, for example: Outlet Group1 is called Monitor for association with the monitor and Outlet Group2 is called Computer for association with the CPU. These records can improve the efficiency of your management. Don't forget to press the Update button.

**Update:** Updates your change.

Log Management

![Log Management window]

Please consider about the free space in your hard disk.

**Maximum Event Log Entries:** Always 1609 UPS Management to preserve less than the assigned entries of event log.

**Data Log Interval:** Time designated for automatic saving of a record of UPS data.

**Maximum Data Log Storage:** It allows you to save how many months UPS data files you wish to keep.
**Schedule**

This function allows you to shutdown, restart, test and turn on/off outlet. You can schedule up to 6 events. Settings are based on day, week or month and up to a period of 2 years.

Choose the applicable schedule to set whether it be for:

- **One Time**: This set schedule is applicable for a single day.
- **Daily**: This set schedule is applicable for every day
- **Weekly**: This set schedule is applicable for once a week period.
- **Monthly**: This set schedule is applicable for once a month period.
Action

The action menu provides you with a list of events to choose from. The event and/or any combination of these actions can be selected from the Choose Event list box. Actions that are already enabled will show a check mark. To delay the actions, set the desired time for delay in the Delay combo box.

Enable Auto-Save: 1609 UPS Management will save opened files and close applications automatically when you enable this function.

Choose Event: When you select one item in the list the action buttons will display current settings. Press button to do further configurations.

Set Default: Set all the actions to default values.

Delay: The power event must stay within the delay time to trigger actions.

Action – Shutdown

Shutdown/Hibernate/Suspend the operating system or shutdown UPS. If you select shutdown item 1609 UPS Management Software will execute or ignore the Auto-Save function depending on your selection in the Action dialog box. But if you select the “suspend” or “hibernate” item, the program will ignore the Auto-Save function.

The action of “shutdown”, “hibernate” or “suspend” are the same as if you select the Shutdown option from the Windows Start menu.

Action – Logging

Allows you to log events as well as modify the default logging message. You can see this message in the Event Log dialog box.

Action – Broadcasting

Permits you to broadcast an event based on a set period of time. If you want to be notified once, set the time period to ‘0’. However, if you want to be notified more than once, set the time period to a larger number. Each number corresponds to the number of times of notification.

Action - SMS(Short Message Service)

Permits you to send SMS through GSM modem or mobile phone. You can edit the user list by clicking the Edit list button, and add, modify or delete any user name in the list. To enable or disable this action, mark the Enable SMS check box.
**Action – Paging**

Allows you to set the time period for paging intervals. If you want to be notified once, set the time period to "0". However, if you want to be notified more than once, set the time period to a larger number. Each number corresponds to the number of times of notification.

**Action- Command**

Permits you to execute command files and set a period of time to delay its activation. To test this function, you can click the Test button. To enable or disable this action, mark the Enable Command check box.

**Action – Alarm**

Permits you to send out audible alarm instead of a broadcast message. There are two alarms to select from - Buzzer and Audio. If you choose Audio, the 1609 UPS Management Software requires a "wav" file to emit the alarm. You can browse your system for other "wav" files by clicking on the Browse button. If you want to be notified once, set the time period to "0". However, if you want to be notified more than once, set the time period to a larger number. Each number corresponds to the number of times of notification.

**Action - e-mail**

Permits you to send e-mails through SMTP. If you want to be notified once, set the time period to "0". However if you want to be notified more than once, set the time period to a larger number. Each number corresponds to the number of times of notification. You can edit the user list by clicking the Edit list button, and add, modify or delete any user name in the list. To enable or disable this action, mark the Enable e-mail check box.

**Action - SNMP Trap**

Lets you send a SNMP trap when the relative power event occurs. To enable or disable this action, mark the Enable SNMP Trap check box. You also need to specify the SNMP Trap target hosts and community string, please see the SNMP dialog box in the Network menu.
Action - Receptacle Control

Allows you to control the Receptacle Relay on or off. Each Receptacle Relay may control not only one outlet, please see the rear panel of your UPS or the UPS hardware user’s manual.

Stop All Action

Clicking on this, terminates all the actions immediately.

Voltage Sensitivity

Adjust the UPS voltage sensitivity.

Transfer Voltage

Changes the low transfer voltage and high transfer voltage. This function lets your UPS adjust to the local power environment.

Low Transfer Voltage: When utility power voltage drops lower than the assigned value the UPS will switch to backup mode. The output power is supplied from the battery.

High Transfer Voltage: When utility power voltage rises higher than the assigned value, the UPS will switch to backup mode. The output power is supplied from the battery.
**Advanced UPS Property**

If your UPS doesn't support this function, the item will be displayed as gray and the user cannot select this item.

Enable Wakeup Computer: If your computer architecture is compatible to ATX and the BIOS supports RS-232(RI) Wakeup function. You should enable this item to make the Schedule work correctly.

Enable Resume Computer: Be sure the BIOS supports RS-232(RI) Wakeup function. When 1609 UPS Management Software suspends the computer and the UPS detects the change of power status, the UPS will resume the computer to its prior operating status and let 1609 UPS Management Software notify users.

Enable Power Fail, Auto-Reboot: The time-line describes below:

<table>
<thead>
<tr>
<th>Input Power</th>
<th>Power Fail</th>
<th>Power Restore</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>Countdown to Shutdown PC</td>
<td>Shutdown PC</td>
</tr>
<tr>
<td>UPS</td>
<td>Backup</td>
<td>Countdown to Shutdown UPS</td>
</tr>
<tr>
<td></td>
<td></td>
<td>UPS Restart to Turn PC on</td>
</tr>
</tbody>
</table>

If you enable this function, the UPS will reboot to restart the computer otherwise, it goes back to its normal state.

Enable Economic Mode: Switches to UPS economic mode.

UPS Periodic Auto-Test: Daily, weekly, biweekly and monthly. UPS starts the test procedure automatically when it reaches the test time.
Network

Set Password

Sets the 1609 UPS Management Service password.

Choose Master/Slave

Sets the 1609 UPS Management Service password.
Please refer to the 1609 UPS Management Service operation mode. If the computer connects to UPS directly (with RS-232 or USB) and can send commands to its connected UPS then the 1609 UPS Management Service acts as a “Master”. If it connects to UPS directly (with RS-232 or USB) but only listens to UPS then it is a "USB Slave". If the computer is powered by the UPS, but obtains the UPS information from Master via TCP/IP network then it is a "Networking Slave". When 1609 UPS Management Service is a Networking Slave you must assign the Master IP address so that the Networking Slave can connect to the Master and obtain the UPS information.

**Master:** Configures the 1609 UPS Management Service to be a Master.

**USB Slave:** Configures the 1609 UPS Management Service to be a USB Slave.

**Networking Slave:** Configures the 1609 UPS Management Service to be a Networking Slave.

**Master IP Address:** When 1609 UPS Management Service is a Networking Slave you must assign the Master IP address so that the Slave can connect to the Master host and obtain the UPS information.

### Wake On LAN

To wake up the remote host, 1609 UPS Management Software sends notification through the network. You must provide the IP address and the network hardware address of the remote host. In Windows 98, you can execute the "ipconfig /All" command under the MS-DOS prompt to obtain the network cards physical address of the local host. Or, input the "arp -a" command to see the remote host’s physical address. Your network card must support the remote wakeup feature and this function should be enabled.

1609 UPS Management Resume The Computer From Suspend Mode:
1609 UPS Management Software will reinstate the computer into normal
mode, and the program will awaken the remote hosts once the actions have been enabled.

Each Time 1609 UPS Management Startup: Program will wake up the remote hosts which are enabled when 1609 UPS Management Software starts and is connected to the UPS.

**SNMP**

**ATTENTION:** If you are using a Windows 95/98/Me operating system, you can configure the SNMP parameters directly from the 1609 UPS Management Software:

Select the Accept SNMP packet from any hosts, 1609 UPS Management Software will accept all the requested commands and set commands. When you select the Accept SNMP packet from the following hosts, 1609 UPS Management Software receives information only from the hosts that you assigned. Once a power event has occurred and the user enables the SNMP Trap in the Action dialog box, 1609 UPS Management Software will send the SNMP trap to the hosts that are listed in the Trap Target list box. To add, modify or delete the host, click on its respective command button.

**ATTENTION:** If you are using a Windows 2000/XP/2003 operating system, you must install the SNMP Service and configure the SNMP parameters from your operating system:

1609 UPS Management Software will ignore the values that were set in the SNMP dialog box. To change the parameters of SNMP function, you should install the SNMP Service in the Network option. Select the SNMP Service from the Network option in the Control Panel and click the Property button to do your changes.
SNMP Trap Number

<table>
<thead>
<tr>
<th>Variable</th>
<th>Trap No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dupslCommunicationLost</td>
<td>1</td>
<td>SEVER: Communication with the UPS failed</td>
</tr>
<tr>
<td>dupslCommunicationEstablished</td>
<td>2</td>
<td>INFORMATION: Communication with the UPS reestablished</td>
</tr>
<tr>
<td>dupslPowerFail</td>
<td>3</td>
<td>WARNING: Power failure: The UPS is operating on battery power</td>
</tr>
<tr>
<td>dupslPowerRestored</td>
<td>4</td>
<td>INFORMATION: Power restored: The utility power restored</td>
</tr>
<tr>
<td>dupslLowBattery</td>
<td>5</td>
<td>SEVER: The UPS batteries are low and will soon be exhausted</td>
</tr>
<tr>
<td>dupslNoLowBattery</td>
<td>6</td>
<td>INFORMATION: The UPS has returned from a low battery condition</td>
</tr>
<tr>
<td>dupslLoadWarning</td>
<td>7</td>
<td>INFORMATION: Loading percent of the UPS over the Load Warning value</td>
</tr>
<tr>
<td>dupslNoLongerLoadWarning</td>
<td>8</td>
<td>INFORMATION: Return from Load Warning condition</td>
</tr>
<tr>
<td>dupslLoadSeverity</td>
<td>9</td>
<td>Warning: Loading percent of the UPS over the Load Severity value</td>
</tr>
<tr>
<td>dupslNoLongerLoadSeverity</td>
<td>10</td>
<td>INFORMATION: Return from Load Severity condition</td>
</tr>
<tr>
<td>dupslUPSFault</td>
<td>11</td>
<td>SEVER: A general fault caused in the UPS</td>
</tr>
<tr>
<td>dupslBatteryGroundFault</td>
<td>14</td>
<td>SEVER: The UPS battery ground fault</td>
</tr>
<tr>
<td>dupslNoLongerBatteryFault</td>
<td>15</td>
<td>INFORMATION: The UPS recovered from battery ground fault</td>
</tr>
<tr>
<td>dupslTestInProgress</td>
<td>16</td>
<td>INFORMATION: The UPS test in progress</td>
</tr>
<tr>
<td>dupslBatteryTestFail</td>
<td>17</td>
<td>SEVER: The UPS test in progress</td>
</tr>
<tr>
<td>dupslFuseFailure</td>
<td>18</td>
<td>SEVER: The UPS fuse failed</td>
</tr>
<tr>
<td>dupslFuseRecovered</td>
<td>19</td>
<td>INFORMATION: The UPS fuse recovered</td>
</tr>
<tr>
<td>dupslOutputOverLoad</td>
<td>20</td>
<td>SEVER: The UPS overload</td>
</tr>
<tr>
<td>dupslNoLongerOverload</td>
<td>21</td>
<td>INFORMATION: Recovered from UPS overload</td>
</tr>
<tr>
<td>dupslOutputOverCurrent</td>
<td>22</td>
<td>SEVER: The UPS output overcurrent</td>
</tr>
<tr>
<td>dupslNoLongerOutputOverCurrent</td>
<td>23</td>
<td>INFORMATION: Recovered from UPS overcurrent</td>
</tr>
<tr>
<td>dupslInverterAbnormal</td>
<td>24</td>
<td>SEVER: The UPS inverter abnormal</td>
</tr>
<tr>
<td>dupslInverterRecovered</td>
<td>25</td>
<td>SEVER: Recovered from UPS inverter abnormal</td>
</tr>
<tr>
<td>dupslRectifierAbnormal</td>
<td>26</td>
<td>SEVER: The UPS rectifier abnormal</td>
</tr>
<tr>
<td>dupslRectifierRecovered</td>
<td>27</td>
<td>INFORMATION: Recovered from rectifier abnormal</td>
</tr>
<tr>
<td>dupslReserveAbnormal</td>
<td>28</td>
<td>SEVER: The UPS rectifier abnormal</td>
</tr>
<tr>
<td>dupslReserveRecovered</td>
<td>29</td>
<td>INFORMATION: The UPS rectifier abnormal</td>
</tr>
<tr>
<td>dupslLoadOnReserve</td>
<td>30</td>
<td>INFORMATION: The UPS load on reserve</td>
</tr>
<tr>
<td>dupslNoLongerLoadOnReserve</td>
<td>31</td>
<td>INFORMATION: The UPS no longer load on reserve</td>
</tr>
<tr>
<td>dupslEnvOverTemperature</td>
<td>32</td>
<td>WARNING: The environment overtemperature</td>
</tr>
<tr>
<td>dupslNoLongerEnvOverTemperature</td>
<td>33</td>
<td>INFORMATION: The environment recovered from overtemperature</td>
</tr>
<tr>
<td>dupslEnvOverHumidity</td>
<td>34</td>
<td>WARNING: The environment overhumidity</td>
</tr>
<tr>
<td>dupslNoLongerEnvOverHumidity</td>
<td>35</td>
<td>INFORMATION: The environment recovered from overhumidity</td>
</tr>
</tbody>
</table>

HTTP

1609 UPS Management Software supports WEB Server for remote manager to obtain the UPS information. Users can use IE or Communicator to connect with 1609 UPS Management Service. Even your computer doesn’t have 1609 UPS Management Software installed you can monitor and control your UPS via network.

![Enable HTTP](image)

**Enable HTTP:** Enable or disable the feature of Web service.

**HTTP Root:** The HTTP root path. All the html and gif files will be located here.

**Port Number:** The default port number is 80 but if there is already one WEB server running you can change 1609 UPS Management Service HTTP port number to a different number. At the Internet Browser you can input http://172.16.176.141:2000 in the URL where 2000 is the assigned port number.
Control

### Shutdown Now

This command will execute the shutdown procedure at once.

**Restart**: This function lets you restart the UPS automatically after being shutdown. To start the UPS for the next schedule, mark the Restart check box.

**Shutdown OS and UPS**: Use this function to shutdown both the OS and UPS.

**SHUTDOWN OS Only**: Use this function to shutdown OS only.

**SUSPEND OS Only**: Use this function to suspend your operating system.

**HIBERNATE OS Only**: Use this function to hibernate your operating system.

### Cancel Shutdown

This menu enables you to terminate the current shutdown procedure.
Turn Receptacle Relay On  

Turns the selected receptacle relay on. Each Receptacle Relay may control more than one outlet, please see the rear panel of your UPS or the UPS hardware user's manual.

- **Select a Receptacle Relay**: Selects a receptacle relay.
- **Delay**: Set the delay time to turn on the receptacle relay.
- **On**: Executes the turn on command.

Turn Receptacle Relay Off  

Turns the receptacle relay off. Each Receptacle Relay may control more than one outlet, please see the rear panel of your UPS or the UPS hardware user's manual.

- **Select a Receptacle Relay**: Selects a receptacle relay.
- **Delay**: Set the delay time to turn off the outlet group.
- **Off**: Executes the turn off command.

UPS Audible Alarm On  

Enables the UPS buzzer. On the Bottom Layer Buttons press the Status button to get the UPS buzzer status.

UPS Audible Alarm Off  

Mutes UPS buzzer alarm.

10 Seconds Test  

UPS switches to backup mode and the output power is supplied by the battery for 10 seconds.

Deep Battery Test  

UPS switches to backup mode and output power is supplied by the battery until the battery is low.

Cancel Test  

This menu allows you to stop test immediately.
Meters

The 1609 UPS Management supports up to 12 meters of real-time values. Each meter has the ability to display all of the UPS values. Selecting different items from the Selection dialog box will display the selected item value.

2,4,6,8,12: Displays meter number.

Selection: Assigns each meter to a different UPS item value.

Close: Closes the meter window.
Event Log

This menu offers you the possibility of viewing past events.

Print: Prints the event log.

Exit: Closes event log dialog box.

History Graph

Clicking on the History Graph opens a dialog box that contains information about the UPS data in graph format. This information is available only if there is an accumulation of data. You can select the month and year you want to view.

Horizontal Scale: Selects the time scale.

Vertical Scale: Selects the value scale.

Select Month: Displays the UPS data for the month

Draw Item1(Blue): Displays the UPS item value by a blue line.
**Draw Item2 (Red):** Displays the UPS item value by a red line.

**Update:** Updates the graph.

**Print:** Exports the graph to a printer.

**Exit:** Closes the history graph dialog box.

**History Data**

Clicking on the History Data opens a dialog box that contains information about UPS data in list form. This information is available only if there is an accumulation of data. You can select the month and year you want to view.

**Select Month:** Displays the UPS data in the month,

**Save As:** Saves the data in the list to the file that you assigned.

**Print:** Exports the list data to a printer.

**Exit:** Closes the history data dialog box.

**Auto Save**

When certain power events occur, 1609 UPS Management will save open files and close applications before shutting down the operating system. If these saved files are untitled, 1609 UPS Management will assign file names for them and put the files in temporary directory. This dialog box will tell you which files were saved by 1609 UPS Management Software.

**Program Title:** The application's title name.

**Auto-Save File Name:** 1609 UPS Management names the file for you.

**Clear:** Clear this record.
Remote Hosts

Detects the hosts, which are running the 1609 UPS Management Service in the LAN. You can also type in the IP address and connect to the WAN.

**Search Result:** The hosts will be listed in the Search Result list box. Select the host you want to connect to and press the Connect button to establish the connection.

**Connect to this IP address:** 1609 UPS Management will connect to the IP address, which you type in.

**Connect:** Establish the network connection.
Bottom Layer Buttons

Each button shows the respective information in the Information Area

**Main**: General Information about the UPS.

**Tree**: There are 2 sub-trees in the 1609 UPS Management tree: System and UPS. The system tree is for host information and the status of Master/Slave connection, the UPS tree is for all other UPS information.

**Time**: Displays the time for all schedules, battery replacement date and countdown time.

**Status**: UPS status.

**Diagram**: Indicates the UPS current flow.

**Scroll**: UPS data graph.

**Outlet**: Displays outlet status. (If your UPS cannot control the outlet then this button disappears)

**Network**: Indicates the connection of Master/Slave, 1609 UPS Management Monitor and 1609 UPS Management Service.

### Main

UPS Health: 3 levels: Green, yellow and red.

UPS Type: On line, off line, line interactive or 3 phase on line.

UPS Model: The UPS model, which is being monitored by 1609 UPS Management Software.

Firmware Version: Indicating the version status of the UPS internal code.

Host Name: The host, which runs 1609 UPS Management Software.

Rating VA: The UPS rating VA.
**Rating Input Voltage**: The UPS rating input voltage.

**Rating Current**: The UPS rating current.

**Rating Battery Voltage**: The UPS rating battery voltage.

**Rating Input Frequency**: The UPS rating input frequency.

**Test Result**: Results of the last self-test.

**AC Source**: Normal or battery

**Battery Status**: The status of battery.

**Battery Level**: Percentage of battery level.

**Loading**: Output loading percentage.

1609 UPS Management Software with the ability to change the display item of the meters, the referred menu item: System-> Main Screen.

**UPS Tree**

- **System**: System tree for host information and the connection of Master/Slave.

- **UPS**: UPS tree for all of the UPS information.

**Time**

- **Last Battery Replacement Date**: To change the date of last battery replacement in the System-> Configuration UPS-> UPS Property.

- **Next Battery Replacement Date**: To change the date of next battery replacement in the System-> Configuration UPS-> UPS Property.

- **Next 10 seconds Test Time**: System-> Configuration UPS-> Schedule.

- **Next Deep Test Time**: System-> Configuration UPS-> Schedule.

- **Next Shutdown UPS Time**: System-> Configuration UPS-> Schedule.

- **Next Restart UPS Time**: System-> Configuration UPS-> Schedule.

**Status**

Shows all of the UPS status, red light indicates this event happened.

**Diagram**

Input and output power flow of UPS.
**Scroll**

Records the most recent UPS data information. You can change the displayed item from System->Main Screen.

**Outlet**

Displays the UPS outlet status (If your UPS cannot control outlet this button disappears).

- **Status**: Identifies the current outlet status: Normal or shut.
- **Next Turn Off Time**: System->Configuration->UPS->Schedule
- **Next Turn On time**: System->Configuration->UPS->Schedule

**Network**

Displays all the 1609 UPS Management Services searched in the LAN.
Notes:
Rockwell Automation Support

Rockwell Automation provides technical information on the Web to assist you in using its products. At http://www.rockwellautomation.com/support, you can find technical manuals, technical and application notes, sample code and links to software service packs, and a MySupport feature that you can customize to make the best use of these tools. You can also visit our Knowledgebase at http://www.rockwellautomation.com/knowledgebase for FAQs, technical information, support chat and forums, software updates, and to sign up for product notification updates.

For an additional level of technical phone support for installation, configuration, and troubleshooting, we offer TechConnectSM support programs. For more information, contact your local distributor or Rockwell Automation representative, or visit http://www.rockwellautomation.com/support/.

Installation Assistance

If you experience a problem within the first 24 hours of installation, review the information that is contained in this manual. You can contact Customer Support for initial help in getting your product up and running.

<table>
<thead>
<tr>
<th>United States or Canada</th>
<th>1.440.646.3434</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outside United States or Canada</td>
<td>Use the Worldwide Locator at <a href="http://www.rockwellautomation.com/support/americas/phone_en.html">http://www.rockwellautomation.com/support/americas/phone_en.html</a>, or contact your local Rockwell Automation representative.</td>
</tr>
</tbody>
</table>

New Product Satisfaction Return

Rockwell Automation tests all of its products to ensure that they are fully operational when shipped from the manufacturing facility. However, if your product is not functioning and needs to be returned, follow these procedures.

<table>
<thead>
<tr>
<th>United States</th>
<th>Contact your distributor. You must provide a Customer Support case number (call the phone number above to obtain one) to your distributor to complete the return process.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outside United States</td>
<td>Please contact your local Rockwell Automation representative for the return procedure.</td>
</tr>
</tbody>
</table>

Documentation Feedback

Your comments will help us serve your documentation needs better. If you have any suggestions on how to improve this document, complete this form, publication RA-DU002, available at http://www.rockwellautomation.com/literature/.

www.rockwellautomation.com